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IV 

INDIVIIDIDEVAHELINE SUGULUS 

4.1 SISSEJUHATUS 

Meeldib see meile või mitte, aga sugulased on omavahel sageli teatud määral sarnased. Üks loomulik 

põhjendus sellisele fenotüübilisele sarnasusele on muidugi sugulaste sarnasemad genotüübid
1
. Et vane-

mailt järglastele päranduvad vaid üksikalleelid, siis saab ka sarnasus väljenduda eelkõige üksikute 

alleelide summaarse ehk aditiivse efekti näol, mistõttu mõistetakse indiviididevahelise geneetilise sar-

nasuse all enamasti just nende aditiivgeneetilist sugulust
2
. 

Kahe indiviidi mingid geenid (alleelid) võivad olla identsed kahel põhjusel: esiteks võib tegu olla liht-

salt juhusliku samasusega (no palju seal populatsioonis ikka neid erinevaid alleele esineb – näiteks 

kahe juhuslikult valitud inimese DNA erineb keskmiselt vaid 0,2% ulatuses) ja teiseks võib tegu olla 

ühiselt eellaselt ühes tükis pärandunud nukleotiidide järjestusega. Geneetikas tehakse neil kahel 

põhjusel rangelt vahet. 

Alleele, mis on oma keemiliselt olemuselt identsed, aga mis ei ei pruugi olla sama eellasalleeli 

koopiad, nimetatakse olemuselt identseteks (identical-by-state – IBS). 

Alleele, mis on ühise eellase ühe konkreetse alleeli keemilised koopiad, nimetatakse päritolult 

identseteks (identical-by-descent – IBD). 

 

Näide 4.1. Olgu kolmes perekonnas (isa, ema ja 2 last), kus eelaste kohta midagi teada ei 
ole, genotüüp määratud ühe markerlookuse osas. Alleelid vaadeldavas lookuses on 
tähistatud numbritega 1, 2 ja 3 ning perekonnad (a), (b) ja (c). Päritolult identsete (IBD) 
ja olemuselt identsete (IBS) alleelide arvud on toodud iga perekonna all. 

 

Perekonna (a) puhul on mõlema haplotüübi pärandumine üheselt tuvastatav – alleel 3 
järglaste genotüübis saab olla pärit vaid emalt, mistõttu peab alleel 1 mõlemal järglasel 
olema saadud isalt, ning kokkuvõttes seega IBS=IBD=2. 

Perekonna (b) puhul on samuti haplotüüpide pärandumine üheselt tuvastatav, Mõlemal 
järglasel on üks olemuselt identne alleel (1), aga et see alleel on saadud erinevatel 
vanematelt, kes eeldatakse suguluses mitteolevaiks, siis IBD=0. 

Perekonnas (c) on mõlemad järglased uuritud lookuse suhtes geneetiliselt identsed, st 

IBS=2, samas ei ole aga võimalik tuvastada alleelide täpset pärandumist, st et võrdse 

tõenäosusega (Mendeli seaduste kohaselt) jagavad kaks järglast kas kahte või mitte ühtegi 

päritolult identset alleeli. 

                                                 
1
 Lisaks elavad sugulased suurema tõenäosusega sarnastes keskkonnatingimustes, neil võib olla sama 

kultuuriline taust jne. 
2
 Lähisugulaste puhul on võimalik nende sugulust lisaks üksikute geenide summaarsele toimele kirjeldada ka 

geenide koosmõju (dominantsi- ja epistaasiefektid) kaudu. Samas ei leia taolised geenide interaktsioonid oma 

teisejärgulise mõju ja kommertsrakendustega (jõudluskontroll jmt) raskesti inkorporeeritavuse tõttu väljaspool 

teadusuuringuid laialdast kasutust. 

 (a) (b) (c) 

1|2 1|3  1|2 1|3  1|2 1|2 

              
 

 

              
1|3 1|3  1|2 1|3  1|2 1|2 

  IBS=2      IBS=1     IBS=2 

  IBD=2      IBD=0     IBD=0 või 2 
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Toodud definitsioonidest järeldub, et kõik IBD-alleelid on ka IBS, aga mitte vastupidi. Genotüüpide 

sarnasuse defineerimisel võetakse aluseks just päritolult identsed alleelid. 

Päritolult identsete allelide esinemistõenäosused on leitavad klassikaliste tõenäosusteooria 

seaduspärade kohaselt, tuginedes teadaolevatele põlvnemisseostele ja eeldades Mendeli 

pärandumisseaduste kehtimist, ning nende tõenäosuste kaudu on defineeritud erinevad 

indiviididevahelised suguluskoefitsiendid. 

 

 



VL.0192  Loomade aretusväärtuse hindamine ja aretusprogrammid 

Tanel Kaart EMÜ VL   

tanel.kaart@emu.ee 2011 

3 

4.2 SUGULUSKOEFITSIENDID 

4.2.1 Klassikaline suguluskoefitsient 

Kahe indiviidi vaheline suguluskoefitsient on defineeritud kui tõenäosus, et ühe indiviidi juhuslikult 

valitud lookusest juhuslikult valitud alleel on päritolult identne teise indiviidi samast lookusest 

juhuslikult valitud alleeliga. 

Taolise koefitsiendi võttis nime coefficient de parenté all 1948. aastal kasutusele 

prantsuse statistik G. Malécot; tänapäeval on enam levinud ingliskeelsed 

nimetused coancestry, kinship coefficient või coefficient of consanguinity. 

Tähistatakse suguluskoefitsienti enamasti tähega f (Falconer ja Mackay, 1996) või 

Φ (Balding, Cannings ja Bishop, 2007) või Θ (Walsh ja Lynch, 1998)
 3
 

(fXY, ΦXY ja ΘXY märgivad siis indiviidide X ja Y vahelist suguluskoefitsienti). 

 

Olgu indiviidide X ja Y genotüübid mingis juhuslikult valitud lookuses vastavalt Ai1Ai2 ning Aj1Aj2. 

Arvutused suguluskoefitsiendi leidmiseks on koondatud järgmisesse tabelisse. 

Juhuslikult valitud alleel ja vastav tõenäosus  Valituks osutunud alleelipaar 

ja vastav tõenäosus 

 Tõenäosus, et 

valitud alleelid 

on päritolult 

identsed 

Indiviid X Indiviid Y   

Alleel Tõenäosus Alleel Tõenäosus  Alleelipaar Tõenäosus  

Ai1 ½ Aj1 ½  Ai1 ja Aj1 ½×½ = ¼  P(Ai1 = Aj1) 

Ai1 ½ Aj2 ½  Ai1 ja Aj2 ½×½ = ¼  P(Ai1 = Aj2) 

Ai2 ½ Aj1 ½  Ai2 ja Aj1 ½×½ = ¼  P(Ai2 = Aj1) 

Ai2 ½ Aj2 ½  Ai2 ja Aj2 ½×½ = ¼  P(Ai2 = Aj2) 

Vastavalt täistõenäosuse valemile on suguluskoefitsient esitatav kõikvõimalike alleelipaaride valituks 

osutmise tõenäosuste ning nende alleelide päritolult identne olemise tõenäosuste korrutiste summaga 

(so tabeli kahes viimases veerus paiknevate tõenäosuste korrutiste summa): 

,

1
1 1 1 2 2 1 2 2 4

P(2 juhuslikult valitud alleeli on IBD)

[P( | juhuslikult valitud alleelid on  ja ) P(juhuslikult valiti alleelid  ja )]

[P( ) P( ) P( ) P( )] .

XY

i j i j i ji j

i j i j i j i j

f

A A A A A A

A A A A A A A A

 (4.1) 

Et tegu on juhuslikult valitud lookusega ja alleelidega, siis iseloomustab seosega (4.1) defineeritud 

päritolult identsete alleelide proportsioon kogu võrreldavate indiviidide genotüüpi. 

 

Näide 4.2. 

Kui indiviidid X ja Y on omavahel suguluses mitteolevate vanemate täisõvedest järglased, 
on nende iga kahe alleeli päritolult identsuse (samalt vanemalt pärandumise) tõenäosus ¼ 
ja suguluskoefitsient XYf  avaldub kujul: 

1 1 1 1 1 1
4 4 4 4 4 4( )XYf . 

Iga indiviidi, kelle vanemad ei ole omavahel sugulased, Malécot’i suguluskoefitsient 

iseendaga on ½: 

1
4

1 1
4 2

[P( ) P( ) P( ) P( )]

(1 0 0 1) .

XX i i i j j i j jf A A A A A A A A
 

 

Tabelis 4.1 on esitatud suguluskoefitsientide väärtused erinevate sugulusastmete korral. 

                                                 
3
 D. S. Falconer, T. F. C. Mackay. 1996. Introduction to Quantitative Genetics. Longman Group Ltd. 

D. J. Balding, C. Cannings, M. Bishop. 2007. Handbook of Statistical Genetics. 3rd Revised edition. John Wiley 

and Sons Ltd. 

M. Lynch, B. Walsh. 1998. Genetics and Analysis of Quantitative Traits. Sinauer Associates, Inc. 

G. Malécot 
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4.2.2 Aditiivgeneetilise suguluse kordaja 

Klassikalise (Malécot’i) suguluskoefitsiendi puuduseks on tema pisut segadusseajavad väärtused 

intuitiivselt tajutavate sugulussidemete korral – näiteks eelnevas näites tuletatud sugulus iseenesega on 

½ või sugulus vanema ja järglase vahel ¼ (kuigi kõik teavad, et järglane saab oma vanemailt pooled 

geenidest). Põhjus on siin selles, et Malécot’i suguluskoefitsient on defineeritud vaid ühe alleeli tarvis. 

Et tegelikult on organismis igast geenist kaks koopiat, siis on nende summaarse mõju uurimisel 

otstarbekas kasutada nn aditiivgeneetilise suguluse kordajat ehk põlvnemiskoefitsienti (additive 

genetic relationship coefficient, coefficient of parentage), mis mõõdab päritolult identsete alleelide 

osakaalu kahe indiviidi genotüübis ja mis võrdub kahekordse klassikalise suguluskoefitsiendiga: 

 2XY XYa f . (4.2) 

Viimane seos tuleneb järgmisest avaldisest (indiviidide X ja Y genotüübid mingis juhuslikult valitud 

lookuses on vastavalt Ai1Ai2 ning Aj1Aj2): 

1 2

1 1 1

P(indiviidi  juhuslikult valitud alleel on IBD ükskõik kummaga indiviidi  alleelidest)

[P( | juhuslikult valitud alleel on ) P(juhuslikult valiti alleel )]

{[P( ) P(

XY

i j i j i ii

i j i j

a X Y

A A A A A A

A A A A 1 1
2 2 1 2 22 2)] } {[P( ) P( )] }

2 .

i j i j

XY

A A A A

f

 

Lisaks tähisele aXY märgitakse indiviidide X ja Y vahelist aditiivgeneetilise suguluse kordajat ka kujul 

rXY (Falconer ja Mackay, 1996) või RXY (Teinberg, 1978)
 4
. 

Enamasti korrelatsioonikordaja puhul kasutatav tähis r ja kordaja sageli eesti 

keeles kasutatav nimetus „suguluskoefitsient“ on pärit USA geneetiku Sewall 

Wright’i töödest, kes aditiivgeneetilise suguluse kordajaga samu väärtusi 

omandava kordajani jõudis juba 1922. aastal, mõõtes indiviidide genotüüpide 

suhtelist sarnasust vanematelt päritud gameetide vahelise korralatsiooni kujul ja 

nimetades oma kordajat coefficient of relationship. 

 

 

Näide 4.3. 

Kui indiviidid X ja Y on omavahel suguluses mitteolevate vanemate täisõvedest järglased, 
on nende vaheline suguluskoefitsient 1

4XYf  (näide 4.2) ja aditiivgeneetiline sugulus 
seega 1

2XYa . 

Et iga indiviidi, kelle vanemad ei ole omavahel sugulased, suguluskoefitsient iseendaga 
on ½, siis järelikult aditiivgeneetiline sugulus iseendaga 1XXa . 

 

Tabelis 4.1 on esitatud aditiivgeneetilise suguluse kordajate väärtused erinevate sugulusastmete korral. 

 

4.2.3 Dominantse suguluse kordaja 

Indiviidide X ja Y vaheline dominantse suguluse kordaja (coefficient of fraternity) on tõenäosus, et 
indiviidide X ja Y genotüübid Ai1Ai2 ja Aj1Aj2 suvaliselt valitud lookuses on päritolult identsed: 

1 2 1 2P( )XY i i j jA A A A . 

See, et genotüübid on päritolult identsed, tähendab, et vastavad alleelid peavad olema päritolult 
identsed – ehk siis Ai1Ai2 = Aj1Aj2, kui Ai1 = Aj1 ja Ai2 = Aj2 või Ai1 = Aj2 ja Ai2 = Aj1: 

1 2 1 2 1 1 2 2 1 2 2 1P( ) P( ) P( ) P( ) P( )XY i i j j i j i j i j i jA A A A A A A A A A A A . 

                                                 
4
 R. Teinberg. 1978. Põllumajandusloomade geneetika. Tallinn, Valgus. 

Segadusseajavalt nimetatakse antud raamatus (nagu ka paljudes teistes materjalides) aditiivgeneetilise suguluse 

kordajat lihtsalt suguluskoefitsiendiks. 

Sewall Wright 
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Kui nüüd oletada, et alleelid Ai1 ja Aj1 on pärandunud indiviidide X ja Y isadelt SX ja SY, siis 

1 1P( ) X Yi j S SA A f (sest see, millised alleelid indiviidide X ja Y isad neile pärandavad, on juhuslik, 
mistap on isadelt pärandunud alleelide päritolult identsuse tõenäosus definitsiooni kohaselt võrdne 
isade vahelise suguluskoefitsiendiga. Järelikult ka 2 2P( ) X Yi j D DA A f , kus alleelid Ai2 ja Aj2 on 
pärandunud indiviidide X ja Y emadelt DX ja DY ning X YD Df  on emade vaheline suguluskoefitsient. 
Samuti 1 2P( ) X Yi j S DA A f  ja 2 1P( ) X Yi j D SA A f . 

Kokkuvõttes on kahe indiviidi vaheline dominantse suguluse kordaja esitatav nende indiviidide 
vanemate suguluskoefitsientide kaudu kujul 

X Y X Y X Y X YXY S S D D S D D Sf f f f . 

Lisaks tähisele ΔXY märgitakse dominantse suguluse kordaja mõnikord ka kujul dXY. 

 

Näide 4.4. 

Kui indiviidid X ja Y on omavahel suguluses mitteolevate vanemate täisõvedest järglased, 
on nendel nii ühine ema kui ka ühine isa. St, et DX = DY = D, SX = SY = S ja seega 

1 1 1
2 2 40 0XY SS DD SD DSf f f f . 

 

Tabelis 4.1 on esitatud erinevate suguluskoefitsientide väärtused erinevatel sugulusastmetel olevate 
indiviidide vahel. 

 

Tabel 4.1. Erinevate suguluskefitsientide väärtused erinevate sugulusastmete korral inbriidingu puudumisel. 

Sugulusaste 

(ja vastav lühend) 

Suguluskoefitsient 

fXY  (või ϕXY, ½rXY) 

Aditiivgeneetilise 

suguluse kordaja 

aXY (või rXY, RXY) 

Dominantse 

suguluse kordaja 

ΔXY (või dXY) 

Indiviid ise ½ 1 1 

Ühemunarakukaksikud (MZ) ½ 1 1 

Kahemunarakukaksikud (DZ) ¼ ½ ¼ 

Täisõved (FS) ¼ ½ ¼ 

Poolõved (HS) ⅛ ¼ 0 

Vanem ja järglane (PO) ¼ ½ 0 

Vanavanem ja lapselaps ⅛ ¼ 0 

 

4.2.4 Inbriidingukoefitsient 

Sõltumatute sündmuste tõenäosuste lineaarkombinatsioonina avaldunud suguluskoefitsientide 
arvutamine muutub keerulisemaks sugulasaretuse korral. Viimane tähendab omavahel suguluses 
olevate indiviidide ristamist, toob kaasa homosügootsuse suurenemise ja tingib selle, et uuritava 
indiviidi samas lookuses paiknevate alleelide Ai ja Aj päritolult identsuse tõenäosus ei pruugi enam 
võrduda nulliga, P( ) 0i jA A . 

Sugulasaretuse osa indiviidi X genotüübis peegeldab inbriidingukoefitsient XF , mis on defineeritud 
kui tõenäosus, et indiviidi juhuslikult valitud lookuses paiknevad alleelid Ai ja Aj on identsed 
päritolult: 

P( )X i jF A A . 

Uurime järgnevalt näiteks, kuidas muutub vanema ja järglase vaheline sugulus, kui vanema 

inbriidingukoefitsient on nullist suurem. 

Võtame vaatluse alla vanema X, alleelidega uuritavas lookuses Ai ja Aj, ning 

järglase O, alleelidega uuritavas lookuses Ak ja Al.  

On selge, et üks alleelidest Ak või Al peab olema identne kas alleeliga Ai või 

alleeliga Aj. Eeldades, et vanemindiviidi alleelid Ai ja Aj on erinevad, avaldub 

vanema ning järglase vaheline suguluskoefitsient vastavalt valemile (4.1) kujul: 

X 

(AiAj) 
 

O 

(AkAl) 
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P( ) P( ) P( ) P( ) 1

4 4

i k i l j k j l
XO

A A A A A A A A
f , (4.3) 

sest murru lugejas olevaist tõenäosustest saab vaid üks olla võrdne 1-ga ning kõik ülejäänud kolm 

võrduvad 0-ga.  

Samas on siiski võimalik, et  

 P( ) 0i j XA A F , (4.4) 

st, et indiviidi X emal ja isal on ühine eellane, kelle sama alleeli koopiad võivad olla nii alleel Ai kui ka 

alleel Aj.  

Oletame konkreetsuse mõttes, et järglasele on vanemalt pärandunud alleel Ai nii, et P( ) 1i kA A . 
Tänu seosele (4.4) kehtib siis ka seos P( )j k XA A F , mistõttu on vanema ja järglase vahelise sugu-
luskoefitsiendi arvutamise valem (4.3), arvestades vanema võimalikku inbriidingut, ümber kirjutatav 
kujul 

1 1
4 4

1 0 0

[P( ) P( ) P( ) P( )] (1 )

X

XO i k i l j k j l X

F

f A A A A A A A A F . 

Analoogse tulemuse saame ka, eeldades alleeli Ak asemel alleeli Al pärandumist. 

Vanema ja järglase vaheline aditiivgeneetiline sugulus on tänu seosele (4.2) leitav valemist  

1
2 (1 )XO Xa F . 
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4.3 MEETODID SUGULUSKOEFITSIENTIDE LEIDMISEKS 

4.3.1 Wright’i rajakoefitsientide meetod 

Eelmise punkti lõpetanud tuletuskäiguga sarnase arutelu tulemusena on võimalik leida ka üldisemad 
suguluskoefitsientide seaduspärad, mis baseeruvad kõigi suguluses olevate indiviidide vaheliste teede 
(radade, inglise keeles path) läbikäimisel sugupuus ja millised esmakordselt tuletas Sewall Wright (siit 
ka meetodi nimetus – Wright’i rajakoefitsientide meetod). 

Võtame näiteks vaatluse alla indiviidid X ja Y, kellel on ühine mitmete põlvkondade tagune eellane W. 
Kuna me oleme huvitatud vaid päritolult identsetest alleelidest, peame 
indiviidide X ja Y vahelise suguluse tuvastamiseks võtma vaatluse alla 
tee X–...–W–…–Y (kui sama alleeli võimaliku pärandumise raja). 

Kui indiviid W on X-i ja Y-i vanem (X ja Y on poolõved) ning 0WF , 
siis  

1 1 1 1 1 1
4 8 8 8 8 8

P( ) P( ) P( ) P( )

( )
k k k l l k l l

XY

A A A A A A A A

f  

ja 1
4XYa . Kui aga 0WF , siis 

1 1 1 1 1 1 1 1 1 1
4 8 8 8 8 8 8 8 8 8

P( ) P( ) P( ) P( )

( ) (1 )

k k k l l k l l

XY W W W W W

A A A A A A A A

f F F F F F . 

Kui indiviidi W näol on tegu varasema eellasega, siis tuleb suguluskoefitsienti korrutada ½-ga iga 
täiendava indiviidide X ja W või Y ja W vahelise generatsiooni kohta, sest iga generatsiooniga väheneb 
sama alleeli pärimise tõenäosus ½ korda. Näiteks kui indiviid W on indiviidi X vanem, aga indiviidi Y 
vanavanem, siis 1 1

2 8[ (1 )]XY Wf F . 

Üldkujul avaldub suguluskoefitsient järgmiselt: 

11 1 1
2 2 2[( ) (1 )] ( ) (1 )n m n m

XY W Wf F F , 

ning aditiivgeneetilise suguluse kordaja on 

1
2 (1 )

n m
XY Wa F , 

kus n ja m tähistavad vastavalt indiviidide X ja W ning Y ja W vahelist kaugust. 

Kuna erinevaid radu indiviididest X ja Y ühise eellaseni W võib olla mitmeid, tuleb kõik need ühise 

alleeli edasikandumisvõimalused suguluskoefitsientide arvutamisel arvesse võtta. Tulemuseks on 

summa üle kõigi radade ühise eellaseni: 

1
2

1

(1 )
j j

k n m
XY W

j

a F , 

kus k tähistab erinevate radade arvu ning nj ja mj tähistavad vastavalt indiviidide X ja W ning Y ja W 

vahelist generatsioonide arvu läbi j. raja. 

Kui ühiseid eellasi on mitu, on vajalik summeerimine üle nende kõigi: 

, ,1
2

1 1

(1 )
i

i j i j

i

l k n m
XY W

i j

a F , (4.5) 

kus l tähistab ühiste eellaste arvu, ki erinevate radade arvu indiviididest X 
ja Y ühise i. eellaseni Wi, ,i jn  ja ,i jm  tähistavad vastavalt indiviidide X ja 
Wi ning Y ja Wi vahelist generatsioonide arvu läbi j. raja ning iWF  on i. 

ühise eellase Wi inbriidingukoefitsient. 

Analoogselt saame avaldise suguluskoefitsiendi tarvis kujul: 

, , 1
1
2

1 1

(1 )
i

i j i j

i

l k n m
XY W

i j

f F . 

 

W 

(AiAj) 

Y 

(Ak’Al’) 
 

X 

(AkAl) 
 

W1 

Y X 

W2 

Wl 
... 
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O 

X Y 

W Z 

Ö    Ü 

Ä Õ  

Sarnase tõenäosusliku lähenemisega on võimalik seostada indiviidi inbriidingukoefitsient tema vane-
mate suguluskoefitsiendiga ning seeläbi tuletada üldine valem inbriidingukoefitsiendi leidmiseks. 

Oletame, et indiviidi O vanemate X ja Y genotüübid mingis juhuslikult valitud 
lookuses on vastavalt AiAj ning Ai’Aj’ ning vanemate vaheline suguluskoefitsient 
on fXY, vt (4.1). Siis on järglase inbriidingukoefitsient (tõenäosus, et vanemate 
juhuslikult valitud gameedid, mis moodustavad järglase genotüübi, sisaldavad 
vaatlusaluses lookuses päritolult identseid alleelele) võrdne tema vanemate 
suguluskoefitsiendiga: 

1
' ' ' '4P( ) [P( ) P( ) P( ) P( )] .O k l i i i j j i j j XYF A A A A A A A A A A f  

Seega on järglase inbriidingukoefitsient võrdne poolega tema vanemate aditiivgeneetilise suguluse 

kordajast: 

 1
2O XY XYF f a , (4.6) 

mis valemi (4.5) kaudu on esitatav kujul 

 
, ,1 1 1

2 2 2
1 1

(1 )
i

i j i j

i

l k n m
O XY W

i j

F a F . (4.7) 

 

Näide 4.5. Leiame alljärgnevalt toodud põlvnemisskeemist indiviidi O inbriidingu-

koefitsiendi FO ning indiviidide X ja O vahelise sugulus-

koefitsiendi fXO, aditiivgeneetilise suguluse kordaja aXO ja 

dominantse suguluse kordaja ΔXO.  

Indiviidi O vanemad X ja Y omavad ühiseid esivanemaid W ja Z, 
viimastest W on omakorda saadud sugulusaretuse tulemusel. 
Vastavalt valemile (4.7) tuleb OF  arvutamisel leida päritolult 
identsete alleelide tõenäosus kahest põlvnemisteest lähtudes ja 
saadud tulemused liita: 

1 1 1 11 1 1
2 2 2

rada rada

[ (1 ) (1 )]O W Z

X Y X Y

F F F

W Z

. 

Et 0ZF  ja 

1 1 1 11 1 1 1 1
2 2 2 2 2

00

[ (1 ) (1 )] 0,25W ÄÕF F F  

(vaikimisi eeldame, et indiviidid Õ, Ä ja Z pole omavahel suguluses), siis  

51 1 1
2 4 4 4( 1) 9 32 0,28125OF . 

Indiviidide X ja O vahelise suguluskoefitsiendi leidmiseks tuvastame esmalt, et indiviidi-
del X ja O on kaks ühist eellast – W ja Z, ning lisaks on indiviid X indiviidi O vanemaks. 
Otsitav suguluskoefitsient fXO avaldub siis kolme liidetava summana: 

0 1 1 2 1 21 1 1 1
2 2 2 2

rada rada rada

[ (1 ) (1 ) (1 )]XO X W Z

X O X Y O X Y O

f F F F

X W Z

. 

Et  0X WZF f , 1
4WF  ja 0ZF  siis 

51 1 1 1
2 2 8 4 81 1 25 64XOf . 

Indiviidide X ja O vaheline aditiivgeneetilise suguluse kordaja on seega 

2 25 32XO XOa f . 

Dominantse suguluse kordaja tarvis saame vastavalt arvutusvalemile (…), et 

5 51 1
16 4 16 4 5 32XO WX ZY WY ZXf f f f , 

X 

(AiAj) 

Y 

(Ai’Aj’) 

 

O 

(AkAl) 
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C D 

F 

I 

M 

H 

K 

G 

E 

Aahotep I 
Sekvenenra II 

Ahmos I 

Ahmos-

Nefertari 

Thutmosis I 

Hatšepsut 

Amenhotep I 

A B 
Sekvenenra I 

Tetišeri 

Mutneferti 

L 

Thutmosis II 

P 
Neferura 

Joonis 4.1. Osa Egiptuse vaaraode 18. dü-
nastia sugupuu algusest. 

N 

O Thutmosis III 

Isis 

Ahmos II J 

Senseneb 

sest 
1 01 1 1 1

2 2 4 4

rada

5(1 ) (1 )
16WX W

X W

f F

W

, 
1 01 1 1

2 2 4

rada

1(1 ) (1 0)
4ZY Z

Y Z

f F

Z

, 

0 11 1 1 1
2 2 4 4

rada

5(1 ) (1 )
16WY W

W Y

f F

W

  ja  
0 11 1 1

2 2 4

rada

1(1 ) (1 0)
4ZX Z

Z X

f F

Z

. 

 

Keerulisemate põlvnemisskeemide puhul on sugulus- ja inbriidingukoefitsientide arvutamisel Wright’i 

rajakoefitsientide meetodil mõttekas esitada arvutused tabelina, kus on kirjas kõik võimalikud 

mittekattuvad rajad ühise eellaseni ja neile vastavad liidetavad koefitsiendi arvutusvalemis. 

 

Näide 4.6. Joonisel 4.1 on kujutatud osa Egiptuse Uuele riigile aluse pannud vaaraode 18. 
dünastia (1552 e.m.a.) sugupuust. Leiame 
kuninganna Hatšepsuti ja vaarao Thutmosis 
II tütre Neferura inbriidingukoefitsiendi, 
jättes arvesse võtmata vaarao Thutmosis I 
spekulatiivse pärinemise (joonisel katkend-
likud jooned). 

Koondame arvutused alljärgnevasse 
tabelisse.  
 

Tee nij + mij Fi FP liidetav 

LKM 2 0 
31

2( )  

LHEIM 4 FE = ¼ 
51 1

2 4( ) (1 )  

LHFIM 4 FF = ¼ 
51 1

2 4( ) (1 )  

LHECFIM 6 0 
71

2( )  

LHFCEIM 6 0 
71

2( )  

LHFDEIM 6 0 
71

2( )  

LHEDFIM 6 0 
71

2( )  

LHECADFIM 8 0 
91

2( )  

LHEDACFIM 8 0 
91

2( )  

LHFCADEIM 8 0 
91

2( )  

LHFDACEIM 8 0 
91

2( )  

LHECBDFIM 8 0 
91

2( )  

LHEDBCFIM 8 0 
91

2( )  

LHFCBDEIM 8 0 
91

2( )  

LHFDBCEIM 8 0 
91

2( )  
 

3 5 7 9 5 161 1 1 1 1 1 1 1
2 2 4 2 2 8 64 32 64 64( ) 2 ( ) (1 ) 4 ( ) 8 ( ) 0,25 .PF  
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C 

J 

M 

H 

K 

G 

E 

A B 

L 

Z 

X Y 

D 

Kui alleelide pärimisteed lõikuvad (lõikepunktis on ühine eellane), siis tuleb trajektoor sellest ühisest 
eellasest ettepoole (ülespoole) arvestusest välja jätta. 

 

Näide 4.7. Analüüsime põlvnemispuud kõrvaloleval joonisel, leides indiviidi Z 

inbriidingukoefitsiendi. Indiviidi Z vanemate, X ja Y, ühised 

eellased on A, B, C ja H (on ka D, aga põlvnemistee temani 

kulgeb nii X-i kui ka Y-i puhul läbi ühise eellase H, mistõttu 

alleelide põlvnemine seda teed mööda on juba arvesse võetud). 

Koondame arvutused alljärgnevasse tabelisse. 

 

Tee nij + mij Fi FZ liidetav 

XKHLY 4 FH =
1
/8 

51 1
2 8( ) (1 )  

XKGCHLY 6 0 
71

2( )  

XKHDBELY 7 0 
81

2( )  

XKHDBEJMY 8 0 
91

2( )  

XKGCADHLY 8 0 
91

2( )  
 

5 7 8 9 131 1 1 1 1
2 8 2 2 2 256( ) (1 ) ( ) ( ) 2 ( ) 0,05078 .ZF  

 

 

4.3.2 Hendersoni meetod suguluskoefitsientide leidmiseks 

Wright’i rajakoefitsientide meetodi rakendamine vähegi keerulisemate  põlvnemisskeemide korral on 

komplitseeritud. USA farmer, geneetik, statistik ning suure hulga XX sajandil 

aretusteooriat olulisel määral modifitseerinud teadlaste juhendaja nende ülikooli 

päevil,  Charles Roy Henderson, tuletas 1953. aastal meetodi, mis ei lähe mööda 

sugupuud tagasi kõige kaugemate eellasteni nagu Wright’i meetod, vaid hoopis 

alustab neist ja liigub ajas edasi kõige nooremate indiviidideni. 

Hendersoni meetod baseerub kahel lihtsal seaduspäral. 

Väide 1. Aditiivgeneetiline sugulus kahe indiviidi, X ja Y, vahel võrdub keskmise 

aditiivgeneetilise sugulusega indiviidi Y vanemate (W ja Z) ja indiviidi X vahel: 

 1
2 ( )XY XW XZa a a . (4.8) 

Tõestus. Malécot’i suguluskoefitsient indiviidide X ja Y vahel avaldub kujul 

1 1
' ' ' '2 2

1
4

[P( ) P( ) P( ) P( )] [P( ) P( ) P( ) P( )]

1 1
2 4

1
4

[ P( ) P( ) P( ) P( ) ]

{ [P( ) P( ) P( ) P( )]

[P(

m i m j m i m j n i n j n i n j

XY m k m l n k n l

A A A A A A A A A A A A A A A A

m i m j n i n j

m

f A A A A A A A A

A A A A A A A A

A A ' ' ' '

1
2

) P( ) P( ) P( )]}

( ),

i m j n i n j

XW XZ

A A A A A A

f f

 

millest tänu seosele (4.2) järeldub valem (4.8).■ 

Väide 2. Indiviidi Y inbriidingukoefitsient võrdub poolega tema vanemate vahelisest aditiiv-

geneetilisest sugulusest (vt valem (4.6)) ning indiviidi aditiivgeneetiline sugulus iseendaga on  

 1
21 1YY Y WZa F a . (4.9) 

Tõestus. Et  

1 1 1
4 4 2[P( ) P( ) P( ) P( )] (1 1) (1 ),YY k k k l l k l l Y Y Yf A A A A A A A A F F F  

siis valemeist (4.2) ja (4.6) järeldub seos (4.9).■ 

 

 

W 

(AiAj) 

Z 

(Ai’Aj’) 

 

Y 

(AkAl) 
 

X 

(AmAn

) 
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O 

X Y 

W Z 

Ö    Ü 

Ä Õ  

Hendersoni meetod indiviidide suguluskoefitsientide leidmiseks koosneb järgmistest sammudest: 

1. Indiviidid järjestatakse genealoogiliselt, st nii, et vanemad paiknevad enne järglasi. 

2. Konstrueeritakse tabel, kus igale indiviidile vastab üks rida ja üks veerg nii, et vanimale vastab 
esimene rida/veerg ja noorimale viimane rida/veerg. 

3. Tabeli täitmist alustatakse ülemisest vasakust nurgast (vanimast indiviidist) – sedasi garan-
teeritakse, et mingi aditiivgeneetilise suguluskordaja avaldamiseks vajalikud vanemate indiviidide 
vahelised seosed on juba teada ja tabelist lihtsalt mahakirjutatavad. 

4. Kui parajasti vaatluse all oleva indiviidi vanemad ei ole teada, siis kirjutatakse temale vastavasse 
tabeli diagonaalil paiknevasse lahtrisse 1 (aditiivgeneetiline sugulus iseendaga on 1) ja täidetakse 
vastava rea ja veeru lahtrid kuni diagonaalil paikneva lahtrini 0-dega (aditiivgeneetiline sugulus 
põlvnemisskeemis eespool paiknevate indiviididega on 0). Loomakasvatusteaduses nimetatakse 
taolisi loomi, kelle eellaste kohta info puudub, sageli baasloomadeks (base animals). 

5. Kui vaatluse all oleva indiviidi vanem(ad) on teada, siis leitakse  

5.1. vastav diagonaalil paikneva lahtri väärtus tuginedes valemile (4.9) kui üks pluss pool 
vaatlusaluse indiviidi vanemate vahelisest aditiivgeneetilisest sugulusest, ning 

5.2. ülejäänud samas reas ja veerus diagonaallahtrist vastavalt vasakul ja ülal paiknevad väärtused 
tuginedes valemile (4.8) kui pool vaatlusaluse indiviidi vanemate ja konkreetsele 
reale/veerule vastava indiviidi vahelistest aditiivgeneetilise suguluse kordajatest. Kui üks 
vaatluse all oleva indiviidi vanemaist on teadmata, loetakse teiste põlvnemisskeemis 
esindatud indiviidide aditiivgeneetiline sugulus selle vanemaga võrdseks nulliga. 

6. Tabeli täidetuse järel on iga kahe indiviidi vaheline aditiivgeneetiline sugulus välja loetav neile 
vastavate ridade-veergude ristumiskohas paiknevast lahtrist; iga indiviidi inbriidingukoefitsient on 
valemist (4.9) avaldatuna leitav, lahutades vastavast diagonaallahtris paiknevast kordajast arvu 
üks. 

 

Näide 4.7. Vaatame näites 4.5 vaatluse all olnud põlvnemisskeemi ja leiame kõigi 
indiviidide inbriidingukoefitsiendid ja aditiivgeneetilise suguluse 
kordajad. 

Järjestame indiviidid Õ-st kuni O-ni genealoogiliselt ja 
konstrueerime tabeli suguluskordajate tarvis. 

Indiviidid Õ ja Ä on nö baasloomad, kes eeldatakse olevat 
mittesugulased ja kellele vastavatesse tabeli peadiagonaalil 
paiknevatesse lahtritesse kirjutame 1 ( 1ÕÕa  ja 1ÄÄa ) ning 
kellevahelist aditiivgeneetilist sugulust kirjeldavatesse lahtritesse 
0 ( 0ÕÄ ÄÕa a ). 

 
 Õ Ä Ö Ü W Z X Y O 

Õ 1 0        

Ä 0 1        

Ö          

Ü          

W          

Z          

X          

Y          

O          

 

Järgmisel indiviidil, Ö, on teada nii ema kui ka isa, mistõttu leiame tema aditiiv-
geneetilise suguluse iseendaga valemist (4.9) ja aditiivgeneetilise suguluse enesest 
eespool paiknevate indiviididega valemist (4.8): 

1
2

0

1 1ÖÖ ÕÄa a , 1 1
2 2

1 0

( )ÖÕ ÕÕ ÄÕa a a , 1 1
2 2

10

( )ÖÄ ÄÄÕÄa a a . 
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Analoogselt avalduvad indiviidi Ü suguluskordajad iseenese ja oma vanematega. 

Indiviidide Ü ja Ö vahelise aditiivgeneetilise suguluskordaja avaldame valemist (4.8): 
1 1

2 2

1 21 2

( )ÖÜ ÜÖ ÖÄÖÕa a a a . 

 Õ Ä Ö Ü W Z X Y O 

Õ 1 0 ½ ½      

Ä 0 1 ½ ½      

Ö ½ ½ 1 ½      

Ü ½ ½ ½ 1      

W          

Z          

X          

Y          

O          

Analoogselt jätkates (näiteks 11
2 4

1 2

1 1WW ÖÜa a , 1 1
2 2

1 2 1 2

( )WÕ ÖÕ ÜÕa a a , …) saame 

ära täita kogu tabeli. 

 Õ Ä Ö Ü W Z X Y O 

Õ 1 0 ½ ½ ½ 0 ¼ ¼ ¼ 

Ä 0 1 ½ ½ ½ 0 ¼ ¼ ¼ 

Ö ½ ½ 1 ½ ¾ 0 ⅜ ⅜ ⅜ 

Ü ½ ½ ½ 1 ¾ 0 ⅜ ⅜ ⅜ 

W ½ ½ ¾ ¾ 1¼ 0 ⅝ ⅝ ⅝ 

Z 0 0 0 0 0 1 ½ ½ ½ 

X ¼ ¼ ⅜ ⅜ ⅝ ½ 1 9
16  

25
32  

Y ¼ ¼ ⅜ ⅜ ⅝ ½ 9
16

 
1 25

32  

O ¼ ¼ ⅜ ⅜ ⅝ ½ 25
32  

25
32  9

321  

Tabelist saab välja lugeda näiteks, et 9 9
32 321 1 0,28125OF , või et 

25
32 0,78125XOa  (samad tulemused saime ka näites 4.4). 
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4.4 PÕLVNEMISANDMETE HALDAMISE JA ANALÜÜSIMISE TARKVARA 
Pedigree Viewer 

Internetis leidub mitmeid raha eest või suisa tasuta allalaaditavaid põlvnemisandmete haldamiseks, 
graafiliseks esitamiseks ja analüüsimiseks mõeldud arvutiprogramme. Ühe eelkõige loomade aretust 
silmas pidava programmi (mis siiski on rakendatav ka teiste eluvormide põlvnemisandmetel) kirjutas 
Austraalias töötav kvantitatiivse geneetika professor Brian Kinghorn. See programm, mis kannab nime 
Pedigree Viewer ja on tasuta allalaaditav aadressilt 

http://www-personal.une.edu.au/~bkinghor/pedigree.htm, 

võimaldab väga mitmekülgselt hallata ja ekraanil esitada nii suuri kui ka väikeseid sugupuid, arvutada 
nii inbriidingu- kui ka suguluskoefitsiente ja hinnata dispersioonanalüüsi segamudelite abil aretus-
väärtuseid. Programmi uus versioon pakub lisaks võimalusi paaride valikuks. Programmiga kaasneb 
lühike ja küllalt selge abifail (Joonis 4.2) ja mitmed näiteandmestikud, mille abil programmi 
võimalustega iseseisvalt tutvuda. 

Programmi tööks vajalik tabel peab kindlasti sisaldama kolme veergu järjekorras: 

’Indiviid’ | ’Isa’ | ’Ema’, 

millele võivad järgneda veel täiendavad uuritavaid indiviide iseloomustavad näitajad (sugu, vanus, 
pikkus jne). Indiviidid, isad ja emad peavad olema üheselt identifitseeritavad kas siis nime, numbri või 
mingi koodi alusel. Ridade (indiviidide) järjekord andmetabelis on vaba, genealoogiline järjestus ei ole 
vajalik, selle paneb paika Pedigree Viewer ise. Pedigree Viewer’is avatav andmetabel peab enesest 
kujutama fikseeritud veergude eraldajaga (koma, tühik jne) tekstifaili, milles kümnendkohtade 
eraldajana on kasutatud punkti ja mille nime laiend peab olema ’ped’, ’txt’ või ’dat’ – näiteks sobib 
Excel’is tekstifailina salvestatud andmetabel. Ka programmi töö tulemusena modifitseeritud 
(genealoogiliselt järjestatud, inbriidingukoefitsientidega ja/või aretusväärtustega täiendatud) sugupuu 
on salvestav analoogse tekstifailina (ja on soovikorral avatav näiteks Excel’is). 

 

Joonis 4.2. Programmi Pedigree Viewer abifail. 

 

Teadmata emade ja isade tähisena kasutab Pedigree Viewer vaikimisi arvu 0, muude tunnuste 
(fenotüübiväärtused jmt) korral on teadmata väärtuste vaikimisi tähiseks -999999 (Joonis 4.3 [a]). 
Enamasti on aktsepteeritav ka teadmata väärtustele vastavate lahtrite lihtsalt tühjaks jätmine (Joonis 
4.3 [b]), aga taoliselt vormindatud ja samas veergude eraldajana samuti tühikuid kasutavate andme-
tabelite Pedigree Viewer’isse sisselugemine võib lõppeda veateatega ... 

 

http://www-personal.une.edu.au/~bkinghor/pedigree.htm


4. Indiviididevaheline sugulus 

 14 

       [a]        [b] 

Joonis 4.3. Andmetabeli vormindamine Pedigree Viewer’i tarvis. 

 

Indiviide, kelle mõlemad vanemad on teadmata ja kelle kohta ei ole teada ka fenotüübiväärtusi 

(loomad 1 ja 5 joonisel 4.3 toodud tabeleis), ei ole vaja algandmeis eraldi ridadesse kirjutada, Pedigree 

Viewer tekitab üksnes isana või emana esinevatele indiviidele (baasloomadele) vastavad read tabelisse 

ise. 

Pedigree Viewer järjestab avatavas andmetabelis sisalduvad indiviidid genealoogiliselt
5
, jagab nad 

generatsioonidesse ja kujutab sugupuud skemaatiliselt (Joonis 4.4). 

 

 

Joonis 4.4. Programmi Pedigree Viewer ekraanipilt. 

 

 

 

 

                                                 
5
 vanemad paiknevad eespool järglasi 



VL.0192  Loomade aretusväärtuse hindamine ja aretusprogrammid 

Tanel Kaart EMÜ VL   

tanel.kaart@emu.ee 2011 

15 

Lühikokkuvõte nii kogu sugupuu kui ka üksikute generatsioonide kohta on tellitav menüüst View -> 
Statistics. 

Suurte sugupuude korral sageli esineda võivate vigade (sama loom esineb sugupuus mitu korda ja 
seejuures erineva(te) vanema(te)ga või esineb mõni loom nii isade kui ka emade veerus) 
kontrollimiseks on menüüs Tools käsud Check for dublicate IDs ja Check for bisexuality. 

 

Menüürea all paikneva nupurea (Joonis 4.5) abil on võimalik muuta sugupuu paigutust ekraanil, 
värvipaletti (teksti, joonte ja tausta värvi, ja seda eraldi ekraanil kuvamiseks ja välja trükkimiseks), 
teksti fondi suurust ning vanemaid ja järglasi ühendavate joonte kuju ( ).  

 

Joonis 4.5. Programmi Pedigree Viewer nupuriba. 

 

Üksiku indiviidi ja tema sugulaste selekteerimiseks sugupuust on lihtsaim viis klikkida hiire 

parempoolse klahviga soovitul (kuvatakse valitud indiviid koos ühe põlvkonna vanemate ja 

järglastega). Kombineerides omavahel klaviatuuri klahve ’Ctrl’, ’Shift’ ja ’Alt’ ning hiire parem- ja 

vasakpoolset klahvi, on võimalik ekraanil kuvada ühe või mitme indiviidi erineva taseme sugulasi. 

Selekteeritud indiviidi vanemate, järglaste või erineva taseme sugulaste kuvamiseks vajalikud käsud 

on valitavad ka menüüst View -> Relatives (Joonis 4.6). 

 

 

Joonis 4.6. Selekteeritud looma(de) erineva taseme sugulaste kuvamine menüükäskude abil. 

 

Suurte sugupuude puhul, kui andmeid on konkreetse indiviidi hiirega klikkides valimiseks liiga palju, 

on alternatiivina võimalik sisse lülitada funktsioon, mis tõstab esile parajasti hiire kursoriga üle 

libistatava indiviidi nime või koodi (Tools -> Highlight target). 

 

Lisaks on võimalik lasta ka programmil enesel üles otsida teatud tingimusi rahuldavad indiviidid 

(Tools -> Find või nupp , vt Joonis 4.7).  
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Joonis 4.7. Huvipakkuvate (konkreetse nimega, sünniaastaga, sooga, inbriidingukoefitsiendi väärtusega jne) 

indiviidide otsimise aken programmis Pedigree Viewer. 

 

Võimalik on teatud osa sugupuust suuremana kuvamine (Tools -> Zoom In või ), kogu sugupuu 
uuesti korraga ekraanile mahutamiseks tuleb klõpsata nupul  (või Tools -> Zoom Out). 

 

Samuti võib iga indiviidi juurde lisaks vaikimisi kuvatavale nimele või koodile (või hoopis selle ase-
mel) kirjutada mõne teise andmestikus sisalduva väärtuse (näiteks võib skeemil kuvada iga indiviidi 
juures tema isa või sugu, kui viimane on andmestikus olemas; View -> Display Fields või ). 

 

Väga kasulik on kas siis kogu sugupuu või sellest välja valitud väiksema osa optimeerimise ehk nn 
korrastamise võimalus nupu  abil (Joonis 4.8). Uuesti kogu sugupuu ekraanil kuvamiseks tuleb 
klõpsata nuppu . 

 

Valmis kujundatud sugupuu või osa sellest on võimalik salvestada pildifailina bmp-formaadis (Fail -> 
Save image of pedigree diagram). 

 

Otsimaks veerust ’Kood’ 

väärtusi ’Poiss’ 

Võimalik on otsida ka 

huvipakkuvasse vahemikku jäävate 

väärtustega indiviide 

Vaja märkida, kui on soov 

otsida kõiki loomi, kelle ID-

koodis sisaldub väärtus ’Poiss’ 

Tervest sugupuust kuvatakse 

roosa rõngaga märgitult vaid 

selekteeritud loomad koos 

otseste vanemate ja järglastega  
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Joonis 4.8. Esialgne ja korrastatud sugupuu Pedigree Viewer’s. 

 

Võttes arvesse kogu sugupuu andmed on võimalik välja arvutada mistahes kahe indiviidi vaheline 
suguluskoefitsient (Tools -> Coancestry; Joonis 4.9), kõigi indiviidide inbriidingukoefitsiendid (Tools 
-> Inbreeding Coefficients) ning aretusväärtused andmestikus sisalduvatele arvulistele tunnustele 
(Tools -> Run BLUP Analysis). 

Nii aretusväärtused kui ka inbriidingukoefitsiendid lisatakse eraldi veergudena sugupuu aluseks ole-
vasse andmetabelisse ning on seeläbi kuvatavad sugupuus ekraanil ( ) ja kasutatavad otsingus ( ). 

NB! Nupul  klikkimise järgselt loeb Pedigree Viewer andmed uuesti sisse algandmete tabelist, 
kaotades sellega ära kord juba leitud inbriidingukoefitsientide väärtused ja aretusväärtuste hinnangud, 
mis tuleb siis vajadusel uuesti leida. 

 

 

Joonis 4.9. Indiviidide vahelise suguluskoefitsiendi arvutamise aken. 

NB! Pedigree Viewer’i poolt leitakse antud konspektis punktis 4.2.1 käsitletud  suguluskoefitsient, 

aditiivgeneetilise suguluse kordaja võrdub selle kahekordse väärtusega. 
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4.5 ÜLESANDED 

1. a.  Leidke kõrval toodud põlvnemisskeemis looma V inbriidingukoefitsient FV, loomade V ja T  
vaheline aditiivgeneetilise suguluse kordaja aVT Wright’i 
meetodil ja loomade V ja T vaheline dominantse suguluse 
kordaja ΔVT. 

b. Leidke kõigi loomade vahelised aditiivgeneetilise suguluse 
kordajad Hendersoni meetodil. 

 

 

2. Alljärgneval joonisel on esitatud inglise pulli Roan Gauntlet’ sugupuu, mille abil Sewall Wright 
illustreeris 1922. aastal oma inbriidingukoefitsiendi arvutamise metodoloogiat. Pullid on märgitud 
ristkülikutega ja lehmad ovaalidega. 

 

 
 
 

 

 

 

 

 

 

 

 

 

Leidke pulli Royal Duke of Gloster ja lehma Princess Royal vaheline suguluskoefitsient f ja 
dominantse suguluse kordaja Δ ning pulli Roan Gauntlet indbriidingukoefitsient F. 

 

3. Vastake eesti hobuste sugupuu-andmestiku baasil 

(http://ph.emu.ee/~ktanel/VL_0192/eesti_hobused.txt) 

ja programmi Pedigree Viewer abil järgmistele küsimustele. 

a. Kes on ühe enamkasutatava täku Aku 684 E (kood andmebaasis 684E_Aku) vanemad, kui 
palju on sellel täkul järglasi ja kui suur on selle täku inbriidingukoefitsient? 

b. Kui paaritada mära Roosi 3852 E (3852E_Roosi) täkuga Eskort 705 E (705E_Eskort), siis kui 
suur oleks nende järglase inbriidingukoefitsient? 

c. Leidke üles 2 kõige suurema inbriidingukoefitsiendiga hobust sellest andmebaasist ja 
sõnastage mõlema jaoks vähemalt üks põhjus, miks see inbriiding nii kõrge on. 

d. Mis aastal on sündinud selle andmebaasi kõige nooremad hobused, kui palju neid on, mis sugu 
ja värvi nad on, mis värvi on nende vanemad ja kui suured on nende inbriidingukoefitsiendid? 

 

Lord Raglan 

Mistletoe 

Mimulus 

Champion 

of England 

Grand Duke 

of Gloster 

Royal Duke 

of Gloster 

Roan 

Gauntlet 

Princess 

Royal 

Duchess of 

Gloster, 9th 
The Czar 

Carmine 

http://ph.emu.ee/~ktanel/VL_0192/eesti_hobused.txt

